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1. ArcSAP Quick Manager 

1.1 Overview

The Areca Single Admin Portal (ArcSAP) quick manager is a graph-
ical-based device management program specifically designed for 
use in managing and configuring RAID unit implemented using any 
of Areca RAID controllers. The ArcSAP quick manager can scan for 
multiple RAID units in the local and remote systems and provide 
an effective mechanism to configure your RAID units. It also pro-
vides real-time reporting on the status of the complete disk array, 
thus making the task of monitoring disk arrays virtually effortless. 
For power users, the ArcSAP Command Line Interface (CLI) func-
tion also provides the scripting capability for automated tasks and 
customization. 
 

1.2 Installing the ArcSAP Utility

You must have administrator permissions for the computer on 
which you are installing ArcSAP quick manager. Before this proce-
dure began, we assume that the RAID unit and OS are installed 
and operational in your system.

1.2.1 Mac Users

This section describes detailed instructions for installing the Mac 
ArcSAP Quick Manager for the Areca RAID unit on your system. 
This can be done in just a few steps!

1. Download the ArcSAP installer from the website at “http://
www.areca.com.tw/support/s_thunderbolt/thunderbolt_mac.
htm”, the file name begins with “arcsap” followed by the ver-
sion control or insert the RAID unit software CD in the CD-ROM 
drive.

2. Double-click on the zipped file that comes from the website or 
resides at <CDROM>\packages\MacOS to add the installer on 
the Finder.
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3. Double click the arcsap.dmg to make its content available 
(name will be shown up in the Finder sidebar), usually a win-
dow opens showing the content as well.

4. Drag the application from the arcsap.dmg window into Applica-
tions folder to install.

5. Wait for the copy process to finish.

Double click on the “arcsap” link from the Applications folder to 
start your ArcSAP quick manager. By default, the ArcSAP is locked 
to prevent unauthorized accesses to your RAID units. The ArcSAP 
password dialog box appears.

Type your Mac computer password into the Password field and 
click the “OK” Button to open it.

1.2.2 Windows Users

This section describes how to install the ArcSAP quick manager to 
your operating system. Follow the steps below to install the utility 
for Windows.

1. Download the ArcSAP installer from the website at “http://
www.areca.com.tw/support/s_thunderbolt/thunderbolt_win.
htm”, the file name begins with “ArcSAP” followed by the ver-
sion control or insert the RAID unit software CD in the CD-ROM 
drive.

2. Double-click on the zipped file that comes from the website or
resides at <CDROM>\PACKAGES\Windows to unzip it. Double 
click on the “setup.exe” file for installing ArcSAP quick man-
ager.
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4. The InstallShield Wizard opens, preparing to install and click 
on the “Next” button to continue. 

5. When you reach the installation page, click on the “Install”
button to continue.

3. The screen shows Preparing to Install.
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6. A Progress bar appears that measures the progress of the 
ArcSAP quick manager setup. When this screen completes, you 
have completed the ArcSAP quick manager setup.

7. After a successful installation, the “Setup Complete” dialog 
    box of the installation program is displayed. Click on the
    “Finish” button to complete the installation. 

There is one “MRAID” icon showing on your “Programs” folder 
for you to locate ArcSAP quick manager program file folder. The 
“ArcSAP” icon is for you to start up the ArcSAP quick manager. 
Click on the “ArcSAP” program icon to start the ArcSAP quick 
manager. 
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1.3 ArcSAP Main Menu

After starting the ArcSAP quick manager, the main window ap-
pears on the screen. The ArcSAP quick manager window contains a 
Controller Hierarchy, Menu Bar, Raid System Console, and a Recent 
Tasks. The Controller Hierarchy tree lists all hosts — including IP 
addresses — with their connected RAID controllers, RaidSet, and 
Volume Sets. When you click on an item in the Controller Hierarchy 
tree, the Raid System Console shows additional information about 
the selection. All management operations pertaining to the RAID 
units will be performed within the main window. The figure 1-1 
shows the elements contained on the main window.

• The “Menu Bar” displays the available menus. Except for Help, 
all menus provide a list of commands for invoking various RAID 
units and notification operations.

• The “Controller Hierarchy” window at the left of the display 
page lists localHost and remote hosts found on the network, as 
well as currently configured devices.

• The “Raid System Console” window in the right window pane 
provides information and options for a device highlighted in the 
controller hierarchy. 

• The “Recent Tasks” displays events log about localhost and net-
work in the system.

Figure 1-1, ArcSAP Quick Manager Main Window
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Figure 1-2, Controller Hierarchy Window

1.4 Controller Hierarchy

Let’s assume you’ve put all Areca RAID units into a system. The 
ArcSAP automatically scans the localhost RAID units on the system 
and creates an individual RAID storage icon located on left column 
of the “Controllers Hierarchy” screen. The arcsap can see localHost 
RAID adapters only if the archttp service is running background. 
When you double click on a selected element in the Controller Hi-
erarchy tree, child element belonged parent element appears. The 
Controller Hierarchy tree contains icons and text as visual indica-
tors for the Localhost, Network, RAID Controllers, Raid Sets, and 
Volume Sets.

1.4.1 Rescan Device

Right click mouse on the host, this Rescan Device function allows 
you to rescan the network subnet, and find any new RAID units 
added or removed. Rescanning updates the list of available devic-
es shown. For example, if you physically plug in a unit and want 
the ArcSAP to recognize the newly plugged in device, use Rescan 
Device.

ArcSAP default shows the controller name as the target host 
name on the Controller Hierarchy tree. User can change the host 
name for easy identification. In the SNMP configuration page, 
there have two OIDs called sysName and sysLocation which allow 
user to enter this host name. User can enter the controller iden-
tification on the “sysName” and “sysLocation” of “SNMP System 
Configurations”. ArcSAP will use these two OIDs (if existed) to 
replace the host name.
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Figure 1-3, Expand All Controller Hierarchy

1.4.2 Add and Remove Host

The ArcSAP quick manager provides a feature that facilitates 
“Add” and “Remove” from RAID units. Before manager can 
be performed on a particular RAID unit, you need to add first a 
connection between your ArcSAP quick manager station and the 
target RAID unit. Once a connection is established successfully, 
manager can be started. “Remove” is used for breaking the link 
between the ArcSAP manager station and the RAID unit.
 

- Add Host 

A host can be added manually by clicking on the “ ” tab 
and entering the IP address of the local or remote host in the 
“Connect To Server” box.

- Remove Host 
A host can be removed manually by clicking on the target host 

in the “Controller Hierarchy” window and clicking on the “ ” 
tab.

1.4.3 Expand All

You can use the “Expand All” to open all folders at the same time 
to see the contents within. Once mouse click is completed your 
“Controller Hierarchy” window will look like this.
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1.5 Raid System Console

ArcSAP quick manager security ensures that RAID configuration 
changes require password authorization. You are required to login 
to manage any host when you attempt to modify the RAID control-
ler settings after turning on the ArcSAP quick manager or after the 
manager comes back from a period of inactivity. Under configura-
tion modification, verify that you have administrator or root privi-
leges for the selected RAID controller by entering the password you 
use to access the unit: In the Login box, type the login password 
on the RAID unit you selected.

Figure 1-4, Login Box

The correct login gives you full control over the disk array; specify-
ing otherwise, only allows you to view the current configuration of 
the RAID controller. If you highlight an element in the “Controller 
Hierarchy”, tabs and panel display for that element shown on the 
Raid System Console.

1.5.1 Select a RAID Controller

The following tabs display in the “Raid System Console” window 
when you select a specific RAID controller in the “Controller Hier-
archy” window:
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Figure 1-5, Specify a RAID Unit

- Overview 
The ‘Overview’ tab provides general information about the 
RAID controller currently highlighted in the controller hier-
archy. It shows the RAID operations options to configure the 
RAID controller.

(1). Quick Create: create a default configuration, which is 
based on the number of physical disks installed; it can 
modify the volume set Capacity, Raid Level, and Stripe 
Size.

(2). Create RaidSet: is used to create a Raid set. A Raid set 
is a group of disks containing one or more volume sets.

(3). Create Nested (Hybrid) RAID: is used to create a R00/
100/30/50/60 Raid set. R00/100/30/50/60 is a combi-
nation multiple RAID x volume sets with RAID 0 (strip-
ing). Striping helps to increase capacity and performance 
without adding disks to each RAID x array. The operating 
system uses the spanned volume in the same way as a 
regular volume. RAID level 00, 100, 30, 50 and 60 can 
support up to eight RAID set.

(4). Create PassThrough Disk: is not controlled by the RAID 
controller firmware and thus cannot be a part of a volume 
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set. The disk is available directly to the operating system 
as an individual disk. It is typically used on a system 
where the operating system is on a disk not controlled by 
the RAID controller firmware.

(5). Create HotSpare Disk: is used to create the global hot 
spare for the selected controller.

(6). Delete Nested (Hybrid) RAID: is used to delete a R00/
100/30/50/60 Raid se on the selected controller.

(7). Delete HotSpare Disk: is used to delete the global hot 
spare on the selected controller.

(8). Advanced Features: is used to launch the web browser-
based McRAID storage manager. The firmware-embedded 
web browser-based McRAID storage manager is used to 
configure the advanced features. This Advanced Features 
is for user to launch the selected RAID controller web 
browser RAID manager. When you double click on the 
Advanced Features, the “Enter Network Password” dialog 
screen appears.

 

Figure 1-6, McRAID Manager Login Box

Type the User Name and Password. The RAID controller 
default User Name is “admin” and the Password is “0000”. 
After entering the user name and password, click the but-
ton to access the McRAID storage manager. See the Web 
Browser-based Configuration on the user manual detail-
ing the McRAID Storage Manager to customize your RAID 
configuration.
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(9). Mute Beeper: is used to “Disabled” the RAID controller 
alarm tone generator.

- RaidSets 
The ‘RaidSets’ tab provides information about the RAID set 
information on the highlighted RAID controller.

- Volumes 
The ‘Volumes’ tab provides information about the volume 
sets information on the highlighted RAID controller.

- Disk 
The ‘Disk’ tab provides information about the disk information 
on the highlighted RAID controller.

- H/W Monitor 
The ‘H/W Monitor’ tab provides information about the Hard-
ware monitor information on the highlighted RAID controller.

- Events 
The ‘Events’ tab provides information about the event log 
information on the highlighted RAID controller.

- CLI 
The ‘CLI’ tab allows experienced users to manage the RAID 
controller using a Command Line Interface.

1.5.2 Select a RiadSet

The following tabs display in the “Raid System Console” window 
when you select a specific RiadSet number in the “Controller Hier-
archy” window:
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- Overview 
The ‘Overview’ tab provides general information about the 
Raid set currently highlighted in the “Controller Hierarchy” 
window. It shows the RAID operation options to configure this 
Raid set.

(1). Create Volume: is used to create a Raid set. A Raid set 
is a group of disks containing one or more volume sets.

(2). Create HotSpare Disk: is used to create the dedicated 
hot spare for the selected Raid set.

(3). Delete HotSpare Disk: is used to delete the global hot 
spare on the selected Raid set.

(4). Activate Incomplete RaidSet: is used to active an 
incomplete Raid set. If one of the disk drives is removed 
in power off state, the Raid set state will change to “In-
complete State”. If the user wants to continue to operate 
the controller without power-off the RAID unit, the user 
can use the “Activate Incomplete Raid Set” option to ac-
tive the Raid set.

- Member Disks 
The ‘Member Disks’ tab provides information about the disk 
information on the highlighted Raid set.

Figure 1-7, Select a Raid Set
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1.5.3 Select a Volume Set

The following tabs display in the “Raid System Console” window 
when you select a specific volume number in the “Controller Hier-
archy” window:

Figure 1-8, Select a Volume Set

- Overview 
The ‘Overview’ tab provides general information about vol-
ume set currently highlighted in the “Controller Hierarchy” 
window. It shows the RAID operation options to configure this 
volume set.

(1). Delete (volume name): delete the selected volume.
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1.6 Menu Bar

After starting the ArcSAP quick manager, the main window appears 
on the screen. All management operations pertaining to the disk 
array system will be performed within the main window. The Menu 
Bar displays the available menus. Except for Help, all menus pro-
vide a list of commands for invoking various RAID units.

1.6.1 arcsap

The ‘arcsap’ tab allows you to select “Preferences” for application 
settings or “Quit arcsap” for quiet application in the ArcSAP ap-
plication. For Window version ArcSAP application, the “File” tab on 
the “Menu Bar” allows you to select “Setup” for application set-
tings or ‘Exit” for quiet application.

Figure 1-9, arcsap Tab

- About arcsap
When you choose arcsap > About arcsap from the menu 
bar, the utility will show you an informational page which dis-
plays the tool’s version number.

- Preferences 
Preferences controls application settings (“global” settings), 
and is available from the arcsap > Preferences from the 
menu bar at the upper-left corner of the screen. Preferences 
lets you set the ArcSAP quick manager language and notifica-
tion. 



ArcSAP Quick Manager

18

1. General
This general setting is to select your own language, just pull 
down the menu and select the language which you comfort-
able with. You need to restart the application to take effect 
once you change the language.

2. Notification
The ArcSAP quick manager provides four methods of send-
ing notifications: By E-mail, By SNMP, By Windows Messag-
es and By System Log. You can use any of the notification 
methods mentioned above; be reminded though that be-
fore you can use a particular method, you should have the 
proper hardware and software installed in your system.

When ArcSAP quick manager configure with one of the 
methods mention in above. The ArcSAP quick manager 
notifications to occur in response to various disk array 
events. For example, if you configure an email notification, 
the ArcSAP quick manager will send an e-mail to selected 
computers on the network if the event (that just occurred) 
falls within the selected notification level. If the notification 
is detailed enough, the recipient can respond accordingly.

When properly configured, this function can notify the ad-
ministrator of event occurrences in the managed disk ar-
ray system instantly even when he or she is at home, or in 
other places around the globe. The check box allows you 
to select the notification level and type in the ArcSAP quick 
manager.
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Figure 1-10, Notification SettingsSet

(1). Notification Levels
The ArcSAP quick manager classifies disk array events 
into four levels depending on their severity. These in-
clude: Information Level, Warning Level, Serious Level 
and Urgent Level. Select the check boxes for the appro-
priate levels type of system on which you want to send.

• Information Level: cover notification events such as 
initialization of the controller and initiation of the re-
building process.

• Warning Level: include events which require the 
issuance of warning messages.

• Serious Error Notification Level: cover events that 
need immediately attention from the administrator

• Urgent Error Notification Level: is the critical 
level, need immediately action from the administrator.

(2). Enabling an E-Mail Notification
The ArcSAP quick manager sends e-mail messages to 
particular people on the local network or through the 
internet by using the Mail services or others e-mail 
server. You will need these e-mail services to enable 
the e-mail notification function of the ArcSAP quick 
manager. It only allows you to select the users who will 
receive the notification messages, and specify the noti-
fication message for each recipient.
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Figure 1-11, Email Configurations

• Attach log file on event level SERIOUS or 
URGENT: 
You can automatically send event notifications—along 
with a copy of the current controller’s log on event 
level SERIOUS or URGENT—by e-mail to a distribution 
list, thus enabling the information to be opened and 
analyzed from other locations.

In order to add your email account to Arc-SAP email 
setting, you’ll need several pieces of information in-
cluding the type of account, the incoming and outgo-
ing server names, and the encryption method and 
port settings.

(2-1). Email Provider
If your email is from a regional email provider, 
select “Custom” option for you to fill your email 
provider’s outgoing (SMTP) server settings. If 
you’re using a common email service, such as 
Outlook.com or Gmail, use this drop-down box 
to automatically configure your email provider’s 
outgoing (SMTP) server settings.
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(2-2). SMTP Setting
To set up a mail client it’s necessary to configure 
a SMTP server that will take care of the delivery 
of your emails.

• Server: Enter the SMTP email server by “IP 
address” or “Name” when sending an email.

• Port: specify the port number to which the 
ArcSAP quick manager attempts to connect 
to the email server. Parameters value = 1 ~ 
65535. You can switch to a secure port instead 
of the “classical” port 25.

• Encryption: Configure this if this server 
requires an encrypted connection. SMTP email 
transfer doesn’t provide an encryption. So if 
you want to make your connection more se-
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cure, it’s a good choice to use an SSL connec-
tion (Secure Sockets Layers) or a STARTTLS  
extension, that employ a separate port for 
encrypted communication.

• Account: enter the valid account if your SMTP 
mail server requires authentication.

• Password: enter the valid password if your 
SMTP mail server requires authentication.

(2-3). Sender
• Sender Name: Enter the sender name that 

will be shown in the outgoing mail.

• Sender Address: specify the text that will 
show in the “From” field in the sent email. 

(2-4). Recipients
Type the alert receiver email address to enable 
e-mail notification for this particular entrance. 
Notification rules instruct ArcSAP on the notifica-
tions that should be sent when certain types of 
alerts are detected. You can configure the e-mail 
notification function to send a notification to 
multiple users.

(3). Enabling a SNMP Notification
This section discusses how to enable the SNMP traps 
on your RAID storage, and how to control the sending 
of SNMP traps from the ArcSAP quick manager. To send 
the SNMP traps to client SNMP manager such as Net-
SNMP manager using the IP address assigned to the 
operating system, you can simply use the SNMP func-
tion on the ArcSAP monitor utility. The ArcSAP quick 
manager only provides one direction to send the trap 
to the SNMP manager without needing to install the 
SNMP extension agent on the host. If SNMP manager 
requests to query the SNMP information from RAID 
storage, please refer the Appendix D “SNMP Operation 
& Installation”.
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To set up SNMP traps sending function, click on the 
“SNMP Configuration” link. SNMP Trap Configurations 
are set up on this page. This setup screen is shown as 
below:

Figure 1-12, SNMP Trap Configurations

• SNMP Trap IP Address: enter the SNMP trap IP ad-
dress.

• Port: specify the port number to the SNMP trap IP 
address. Parameters value = 1 ~ 65535

• Community: act as a password to screen accesses to 
the SNMP agent of a particular network device. Type 
the community names of the SNMP agent in this field. 
Most network devices use “public” as default of their 
community names. This value is case-sensitive.

Before the client side SNMP manager application ac-
cepts the RAID storage traps, it is necessary to inte-
grate the MIB into the management application’s data-
base of events and status indicator codes. This process 
is known as compiling the MIB into the application. This 
process is highly vendor-specific and should be well-
covered in the User’s Guide of your SNMP application. 
Ensure the compilation process successfully integrates 
the contents of the areca_sas.mib file into the traps 
database. 
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(4). Enabling a Message Notification
The ArcSAP quick manager provides another way to no-
tify selected users on the network by sending messages 
to their respective stations.

(5). Enabling System Log
If you wish to create a system log, tick on a check 
mark in the box beside the “By System Log” dialog box.
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1.6.2 Edit

The ‘Edit’ tab allows you to select “Rescan Device” function for 
LocalHost /Network or ‘Scheduler’ for the selected background 
tasks by selecting on the Action in the ArcSAP application.

- Rescan Device 
Refer to 1.4.1 Rescan Device 

- Scheduler 
The Scheduler page appears when you choose Edit > Sched-
uler from the menu bar. The Scheduler page lets you view 
and change the schedule for background tasks that affect the 
selected controller. 

You select the type of task for which you want to set the 
schedule from the “Action” list on the Scheduler, including: 
MessageBox, Send Mail or Check Volume.

(1). About Task List
You can set up scheduler for when background tasks can 
occur, so that routine maintenance of controller occurs at 
times that will be least likely to interfere with peak I/O 
times. Click on the Add button to add a new entry. When 
you add a new task schedule, you specify the trigger 
condition for the task. If you want to change a scheduled 
task, you edit the scheduled item and then store it. The 
scheduled tasks can be added in any order. To disable 
the scheduler task you either disable “Enabled” field, or 
remove the tests listed in the “Task List” column.

Figure 1-13, Edit Tab
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(2). About Trigger
When you add a new task schedule, you specify the Daily/
Weekly/Monthly, and Recur for the task. The Enabled 
option is used to set schedule times whether scheduling 
is set to be followed or ignored. This is useful if you want 
to temporarily disable the schedule without deleting the 
schedule itself.

• For the Daily option, enter an interval in the ‘Recur 
every days’ field. Specify the start count time from the 
dropdown menu (PgUp/PgDn buttons to set the time).

 

• For the Weekly option, enter an interval in the ‘Recur 
every weeks on’ field and choose one day of the week. 
Specify the start count time from the dropdown menu 
(PgUp/PgDn buttons to set the time).
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• For the Monthly option, enter an interval in the ‘Recur 
every # months on’ field and click on, Day of the Month 
option. Specify the start count time from the dropdown 
menu (PgUp/PgDn buttons to set the time).

 (3). About Action
You select the type of task for which you want to set the 
schedule from the “Action” list on the Scheduler, includ-
ing: MessageBox, Send Mail or Check Volume.

• MessageBox 

In the “Message shows on the message box:” text box, 
specify the message you want to notify selected users.

• Send Mail

In the “Subject” text box, type in the subject you want 
to show on the ongoing e-mail notification. In the “Mes-
sage” text box, specify the message you want to send to 
the selected user.
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• Check Volume

Check Volume function default applies the localhost 
controllers. You can include the network controllers by 
ticking on the check box on the ‘Include remote side 
controllers’. 

A volume check is a process that verifies the integrity 
of redundant data. To verify RAID 3, 5, 6, 30, 50 or 60 
redundancy, a volume check reads all associated data 
blocks, computes parity, reads parity, and verifies that 
the computed parity matches the read parity. You can 
set up scheduling windows for when consistency check 
can occur, so that routine consistency check occurs at 
times that will be least likely to interfere with peak I/O 
times.

1.6.3 RAID Operations

The ‘RAID Operations’ tab allows you to choose the configura-
tion options available to any option highlighted in the “Controller 
Hierarchy” window.

Figure 1-14, RAID Operations Tab
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- Save Controller Settings 
Save the current controller settings to a configuration file on a 
disk. You will be prompted to specify the name and location of 
the backup file. ArcSAP will write the controller configuration 
to one file name: serial #.bin when it’s finished with the instal-
lation and fist-time running. 

- Restore Controller Settings 
Restore controller settings to the controller from a configura-
tion file on a disk. You will be prompted to specify the name 
and location of the file containing the new configuration.

- Collect Controller Data
The “Collect Controller Data” option on the ArcSAP is used to 
download all controller’s information (system information, con-
figuration, disk information and event log) to a supported file 
(file name:ctlrxx-xxxxx.log). It will be automatically started 
when ERROR or SERIOUS event has occurred.

1.7 Recent Tasks

The ArcSAP quick manager keeps a “Recent Tasks” for recording all 
events that occurred in the RAID units on the localhost and net-
work.
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